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1 About this document

Tab. 1.1: Warning symbols and signal words

Symbol indicating dangers to persons

Symbol indicating possible property damage

NOTICE Signal word for property damage
Indicates dangers that may result in property damage if the measures for dan-
ger avoidance are not followed.

CAUTION Signal word for minor injuries
Indicates dangers that may result in minor injury if the measures for danger
avoidance are not followed.

Tab. 1.2: Other symbols

Symbol for tips
Text passages with this symbol provide you with further information.

Symbol for action steps
Text passages with this symbol instruct you to perform actions.

Symbol for action results
Text passages with this symbol describe the result of the preceding action.

Tab. 1.3: Terms and abbreviations

CCD Photosensitive sensor chip
(Charge-coupled device)

CR CCD-based bar code reader
(Code Reader)

DTM Software device manager
(Device Type Manager)

EN European standard

FDT Software frame for management of device managers (DTM)
(Field Device Tool)

FE Functional earth

IO or I/O Input/Output

LED Light Emitting Diode

PLC Programmable Logic Control
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2 Safety
This code reader was developed, manufactured and tested in accordance with the applicable safety stan-
dards. It corresponds to the state of the art.

2.1 Intended use
The CR110 bar code reader is designed as a stationary bar code reader with integrated decoder for all
common bar codes used for automatic object detection.

Areas of application
The CR110 bar code reader is intended especially for the following areas of application:

• Automatic analyzers
• Space-critical bar code reading tasks
• Automation technology

CAUTION

Observe intended use!
The protection of personnel and the device cannot be guaranteed if the device is operated in a
manner not complying with its intended use.
Ä Only operate the device in accordance with its intended use.
Ä Leuze electronic GmbH + Co. KG is not liable for damages caused by improper use.
Ä Read these operating instructions before commissioning the device. Knowledge of the oper-

ating instructions is an element of proper use.

NOTICE

Comply with conditions and regulations!
Ä Observe the locally applicable legal regulations and the rules of the employer's liability insur-

ance association.

2.2 Forseeable misuse
Any use other than that defined under "Intended use" or which goes beyond that use is considered im-
proper use.
In particular, use of the device is not permitted in the following cases:

• in rooms with explosive atmospheres
• in circuits which are relevant to safety
• for medical purposes

NOTICE

Do not modify or otherwise interfere with the device!
Ä Do not carry out modifications or otherwise interfere with the device.

The device must not be tampered with and must not be changed in any way.
Ä The device's housing must not be opened.
Ä There are no user-serviceable parts inside the device.
Ä Repairs must only be performed by Leuze electronic GmbH + Co. KG.
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2.3 Competent persons
Connection, mounting, commissioning and adjustment of the device must only be carried out by competent
persons.
Prerequisites for competent persons:

• They have a suitable technical education.
• They are familiar with the rules and regulations for occupational safety and safety at work.
• They are familiar with the operating instructions for the device.
• They have been instructed by the responsible person on the mounting and operation of the device.

Certified electricians
Electrical work must be carried out by a certified electrician.
Due to their technical training, knowledge and experience as well as their familiarity with relevant standards
and regulations, certified electricians are able to perform work on electrical systems and independently de-
tect possible dangers.
In Germany, certified electricians must fulfill the requirements of accident-prevention regulations DGUV
(German Social Accident Insurance) provision 3 (e.g. electrician foreman). In other countries, there are re-
spective regulations that must be observed.

2.4 Disclaimer
Leuze electronic GmbH + Co. KG is not liable in the following cases:

• The device is not being used properly.
• Reasonably foreseeable misuse is not taken into account.
• Mounting and electrical connection are not properly performed.
• Changes (e.g., constructional) are made to the device.
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3 Device description

3.1 Device overview
The CR110 bar code reader is a CCD based line scanner with integrated decoder for all commonly used
bar codes, e.g. 2/5 Interleaved, Code 39, Code 128, EAN etc.
The many possible configurations of the device allow it to be adapted to a multitude of reading tasks. Due
to the small dimensions of the unit and its wide reading field, the CR110 may also be used in highly con-
strained spaces.
The CR110 bar code reader is operated as a "stand-alone" single device. It is equipped with a six-wire ca-
ble with open ends for the electrical connection of the supply voltage, the interface, the switching input and
the switching output.
Information on technical data and characteristics: see chapter 12 "Technical data".

3.2 Performance characteristics
• High-performance CCD bar code reader with front or lateral beam exit
• Reading field optimized to a reading field height of 80 mm even at short distances
• Compact design for simple integration, even in constrained spaces
• Scanning rate of 780 scans/s facilitates reliable reading, even while in motion
• Reading of all common codes of modulus sizes 150 – 500 μm (6 – 20 mil) at a reading field height of

≥ 80 mm
• Robust metal housing with cable connection
• RS 232 interface, one switching input, one switching output

3.3 Device construction

1 Reading window with lateral beam exit
2 Cable, 2000 mm
3 M3 mounting thread

Fig. 3.1: CR110M0 device construction
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1 Reading window with front beam exit
2 Cable, 2000 mm
3 M3 mounting thread

Fig. 3.2: CR110M2 device construction

3.4 Connection technology
• Cable connection
• Alternative: customer-specific solutions

3.5 Display elements
On the rear of the CR110, a 3-color LED indicates the readiness for operation and the read status of the
bar code reader.

Tab. 3.1: Operation and display

LED Display Meaning
1 Orange, flashing Service operation

Orange, continuous light Reading gate active

Green, 1x flashing Reading successful

Red, continuous light Error

Red, flashing Warning
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4 Mounting
The CR110 can be fastened at the M3 mounting threads on both sides of the device.

4.1 Selecting a mounting location

NOTICE

The size of the bar code module influences the maximum reading distance and the width of the
reading field. Therefore, when selecting a mounting location and/or the bar code label, take into
account the different reading characteristics of the bar code reader with various bar code mod-
ules.

NOTICE

Observe when choosing the mounting location!
Ä Make certain that the required environmental conditions (humidity, temperature) are main-

tained.
Ä Avoid possible soiling of the reading window due to liquids, abrasion by boxes, or packaging

material residues.
Ä Ensure the lowest possible chance of damage to the code reader through mechanical colli-

sion or jammed parts.
Ä Avoid possible ambient light influence (no direct sunlight).

Take the following factors into account when selecting the correct mounting location:
• Size, orientation, and position tolerance of the bar codes on the objects to be scanned.
• The reading field of the CR110 in relation to the bar code module width.
• The CR110 is designed for reading codes in ladder orientation.
• The resulting minimum and maximum reading distance from the respective reading field; see chapter

12.2 "Reading fields".
• Alignment of the bar code reader for avoiding reflections.
• Distance between CR110 and host system with respect to the interface.

Observe the following criteria for the best read results:
• The reading distance is located in the middle part of the read field.
• There is no direct sunlight and protect against ambient light effects.
• The bar code labels are of good print quality and have good contrast ratios.
• Do not use glossy labels.
• The bar code is moved past the reading window with a rotational angle of 10° … 15°.
• The red light beam is narrowed down for its respective reading task in order to avoid reflections on

shiny components.

NOTICE

With front beam exit, the beam exit on the CR110 is nearly vertical to the reading window. With
lateral beam exit, the beam exit is at circa 12° from vertical. The bar code label must be rotated
by > 10° to avoid a total reflection of the red light beam in the case of glossy labels.

α Azimuth angle β Angle of inclination γ Angle of rotation
Recommended angle of rotation: γ > 10°

Fig. 4.1: Definition of the reading angles
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5 Electrical connection

CAUTION

Safety notices!
Ä The device is completely sealed and must not be opened.
Ä Do not try to open the device under any circumstances, as this voids both degree of protec-

tion IP40 and the warranty.
Ä Before connecting the device, be sure that the supply voltage agrees with the value printed

on the name plate.
Ä Connection of the device and maintenance work while under voltage must only be carried

out by a qualified electrician.
Ä The power supply unit for the generation of the supply voltage for the device and the corre-

sponding connection units must have a secure electrical insulation according to UL/
IEC 62368-1.
For UL applications: only for use in ES1/PS1 circuits according to UL/IEC 62368-1.

Ä If faults cannot be cleared, the device should be switched off and protected against acciden-
tal use.

5.1 Voltage supply
The CR110 bar code reader is designed for connection to a 5 V supply voltage.

• +5 V DC (red)
• GND (violet)

Available as an accessory is an adapter circuit board with spring terminals and 9-pin SUB-D socket; see
chapter 13.2 "Accessories".

• With the adapter circuit board, the conductors of the CR110 connection cable can be contacted via the
spring terminals and connected to the PC via the 9-pin SUB-D socket with an RS 232 interconnection
cable.

• With the adapter circuit board, the voltage supply from 10 … 30 V DC can be fed in via spring terminals
or, alternatively, 5 V DC can be fed in via a micro USB connector.

5.2 Conductor assignment

Tab. 5.1: Conductor assignment of the connection cable

Wire color Assignment Description
Red +5 V DC Supply voltage 5 V DC IN

Violet GND Supply voltage 0 V DC / reference ground IN

Black SW OUT Switching output OUT

Orange SW IN Switching input IN

White RS 232 RxD RxD signal line of the RS 232 interface IN

Green RS 232 TxD TxD signal line of the RS 232 interface OUT
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5.3 Switching input and switching output
The CR110 is provided with a switching input and a switching output. You can configure the functions of
the switching input or switching output according to your needs via the Sensor Studio configuration soft-
ware; see chapter 6 "Configuration and diagnostics software – Sensor Studio".

Switching input
By means of the SW IN switching input connection, you can trigger a read process in the standard setting
(low = active) with the connection SW IN (orange) and GND (violet). The 2.2 kΩ "pull-up" resistor must be
connected externally.
Depending on how the switching input is actuated, you can operate it both as NPN (low = active) as well as
PNP (high = active).

1 Red
2 Orange
3 Violet

Connection version NPN: default setting (low = active); input resistance: 36 kΩ

Fig. 5.1: Switching input NPN connection (default setting)

PNP actuation: With the "inverted" setting (high = active), you can trigger a read process by applying a volt-
age of +5 V DC (red) at SW IN (orange).

1 Red
2 Orange
3 Violet

Connection version PNP: "inverted" setting (high = active); input resistance: 36 kΩ

Fig. 5.2: Switching input PNP connection ("inverted" setting)

Switching output
The NPN switching output connection between SW OUT (black) and GND (violet) can be activated in the
bar code reader setup.
In the basic setting, the SW OUT switching output is switched to GND if a code is detected.
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1 Red
2 Orange
3 Violet

Fig. 5.3: Switching output

NOTICE

Maximum loading of the switching output!
Do not load the switching output of the bar code reader with more than 20 mA at
+5 V … +30 V DC.
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5.4 PC or terminal connection
Via the serial interface, you can configure the bar code reader by means of a PC or terminal. For this, you
need an RS 232 connection that establishes the RxD, TxD and GND connections between PC and bar
code reader.
The RS 232 connection can be established in the following ways:

• Direct connection of the CR110 connection wires to the PC or terminal via its own connector.
• Connection via an MA-CR adapter circuit board

To simplify the connection of the connection wires to the PC interface, an adapter circuit board (MA-
CR) is available for implementing individual wire contacting to SUB-D, 9-pin; see chapter 13.2 "Acces-
sories".

1 RS 232 connection
2 CR50 connection
3 CR110, CR100 or CR55 connection
4 Molex Micro-Fit, 6-pin
5 USB connection
6 Connection to machine control, PLC, external voltage supply 5 V DC
7 External voltage supply 10 … 30 V DC
8 SWIN DIP switch (level for trigger button; 5 V if the bar code reader high switching input is active, GND if the low

input is active)
9 USB/PWR DIP switch (USB position if voltage is supplied via USB; PWR position if voltage is supplied via exter-

nal voltage supply (7))
10 Trigger button
11 Status LEDs

Fig. 5.4: Connection options for the MA-CR adapter circuit board

5.5 Cable lengths and shielding
The maximum cable length is 2 m.
If cables are extended, make sure that the cables of the RS 232 interface are shielded.
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6 Configuration and diagnostics software – Sensor Studio
The Sensor Studio configuration and diagnostics software provides a graphical user interface for the opera-
tion, configuration and diagnostics of the device via the RS 232 service interface.
A device that is not connected to the PC can be configured offline.
Configurations can be saved and reopened as projects for transferring back to the device at a later time.

NOTICE

Only use the Sensor Studio configuration software for products manufactured by Leuze.
The Sensor Studio configuration software is offered in the following languages: German, Eng-
lish, French, Italian and Spanish.
The FDT frame application of the Sensor Studio supports all languages; all languages may not
be supported in the device DTM (Device Type Manager).

The Sensor Studio configuration software is designed according to the FDT/DTM concept:
• You make the individual configuration settings for the bar code reader in the Device Type Manager

(DTM).
• The individual DTM configurations of a project can be called up via the frame application of the Field

Device Tool (FDT).
• Communication DTM for bar code readers: LeCommInterface
• Device DTM for the CR110 bar code reader

Procedure for the installation of the software and hardware:
Ä Install the Sensor Studio configuration software on the PC.
Ä Install the communication and device DTM. Communication and device DTM are included in the Le-

AnalysisCollectionSetup installation package.
Ä Create device DTM for CR110 in the project tree of the Sensor Studio FDT frame.
Ä Connect bar code reader to PC; see chapter 5.4 "PC or terminal connection".
Ä Activate service interface on bar code reader; see chapter 7.3.2 "Service mode".

6.1 System requirements
To use the Sensor Studio configuration software, you need a PC or laptop with the following specifications:

Tab. 6.1: System requirements for Sensor Studio installation

Operating system Windows 10 (32 bit, 64 bit)
Windows 11 (32 bit, 64 bit)

Computer Processor type: 2 GHz or higher
Serial COM interface
CD drive
Main memory (RAM): at least 4 GB
Keyboard and mouse or touchpad

Graphics card At least 1024 x 768 pixels

Required hard disk capacity for Sensor Studio and
communication DTM

35 MB

NOTICE

Administrator privileges on the PC are necessary for installing Sensor Studio.
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6.2 Installing Sensor Studio

NOTICE

The installation files of the Sensor Studio configuration software must be downloaded from the
Internet at www.leuze.com.
For subsequent updates, you can find the most recent version of the Sensor Studio installation
software on the Internet at www.leuze.com.

6.2.1 Downloading configuration software
Ä Call up the Leuze website: www.leuze.com.
Ä Enter the type designation or part number of the device as the search term.
Ä The configuration software can be found on the product page for the device under the Downloads tab.

6.2.2 Installing the Sensor Studio FDT frame

NOTICE

First install the software!
Ä Do not yet connect the device to the PC.
Ä First install the software.

NOTICE

If FDT frame software is already installed on your PC, you do not need the Sensor Studio instal-
lation.
You can install the communication DTM and the device DTM in the existing FDT frame. Com-
munication DTM and device DTM are included in the LeAnalysisCollectionSetup installation
package.

Ä Start the PC.
Ä Download the configuration software from the Internet to the PC (see chapter 6.2.1 "Downloading con-

figuration software"). Unpack the installation package.
Ä Start the SensorStudioSetup.exe file.
Ä Follow the instructions on the screen.

ð The installation wizard installs the software and places a shortcut on the desktop (   ).

6.2.3 Install the communication DTM and device DTM
Prerequisites:
ü An FDT frame is installed on the PC.
Ä Start the LeAnalysisCollection.exe file from the installation package and follow the instructions on the

screen.
ð The installation wizard installs communication DTM and device DTM.

6.2.4 Connecting device to PC
The device is connected to the PC via the RS 232 interface.
You need an RS 232 connection that establishes the RxD, TxD and GND connections between PC and de-
vice; see chapter 5.4 "PC or terminal connection".
The +5 V DC voltage supply is to be fed in externally; see chapter 5.1 "Voltage supply".
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NOTICE

The MA-CR adapter circuit board with spring terminals for connecting the CR110, as well as 9-
pin SUB-D socket for connecting an RS 232 interconnection cable, are available as accessories.
An RS 232 interconnection cable to the PC is also available as an accessory; see chapter 13.2
"Accessories".
The adapter circuit board requires 10 … 30 V DC as external voltage supply, which can be fed
in via spring terminals. Alternatively, 5 V DC can be fed in via a micro USB connector.

6.3 Starting Sensor Studio
Prerequisites:
ü The device has been mounted (see chapter 4 "Mounting") and connected (see chapter 5 "Electrical

connection") correctly.
ü The device is connected to the PC via the RS 232 interface (see chapter 6.2.4 "Connecting device to

PC").
ü The service interface is activated on the device (see chapter 7.3.2 "Service mode").
ü The Sensor Studio configuration software is installed on the PC (see chapter 6.2 "Installing Sensor Stu-

dio").

Ä Start the Sensor Studio configuration software by double-clicking the [Sensor Studio] icon (   ).
ð The Mode selection of the project wizard is displayed.

Ä Select the Device selection without communication connection (offline) configuration mode and
click on [Next].
ð The project wizard displays the device selection list of configurable devices.

Fig. 6.1: Device selection list

Ä Select CR110 in the device selection and click on [Next].
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ð The device manager (DTM) of the connected bar code reader starts with the offline view for the
Sensor Studio configuration project.

Ä Establish the online connection to the connected bar code reader.

Ä In the Sensor Studio FDT frame, click on the button [Connect] ( ).

Ä In the Sensor Studio FDT frame, click on the button [Read from device] ( ).
ð The current configuration data is displayed in the device manager (DTM).

Fig. 6.2: Configuration project: Sensor Studio device manager (DTM)

Ä The menus of the Sensor Studio device manager (DTM) can be used to change or read out the config-
uration of the connected device.
ð The user interface of the Sensor Studio device manager (DTM) is largely self-explanatory.
ð The online help system provides information on the menu items and adjustment parameters. Select

the Help menu item in the menu ? (   ).
Ä Transfer the modified configuration parameters to the device.

Ä If a connection exists, click on the button [Transfer to device] ( ) on the task bar.

6.4 Exiting Sensor Studio
After completing the configuration settings, close the Sensor Studio configuration software.
Ä Exit the program via the button Close [x] in the top right corner.
Ä Save the configuration settings as a configuration project on the PC.

You can open the configuration project again at later time via Project > Open.
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6.5 Configuration parameters
In this chapter, you will find information and explanations on the configuration parameters of the device
manager (DTM) for the bar code reader.

NOTICE

This chapter does not include a complete description of the Sensor Studio configuration soft-
ware. Complete information on the FDT frame menu and on the functions in the device manager
(DTM) can be found in the online help system.

The device manager (DTM) for CR110 bar code readers of the Sensor Studio configuration software offers
the following configuration functions:

• Decode; see chapter 6.5.1 "Decode tab"
• Output; see chapter 6.5.2 "Output tab"
• Control; see chapter 6.5.3 "Control tab"
• Host Interface; see chapter 6.5.4 "Host interface tab"
• Reference Code; see chapter 6.5.5 "Reference code tab"
• Sensor; see chapter 6.5.6 "Sensor tab"
• Switch; see chapter 6.5.7 "Switch tab"

NOTICE

The online help system displays information on the menu items and configuration parameters
for each function. Select the Help menu item in the menu ?.
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6.5.1 Decode tab

Fig. 6.3: Decode tab

Code table In the code table, the codes which are to be decoded are set. We recommend
enabling only the code types which are to actually be read with the corre-
sponding element numbers.
Codes which are not enabled are not decoded.

Element number In the field Element number, up to three element entries may be entered.
A range of permissible elements is indicated by a dash, e.g.: 4-40 elements.
To select a range, set the check mark under Interval mode. Up to three fixed
element numbers with comma, e.g.: 8,13 elements.
Both are also possible, but first the range must be specified (select checkbox
Interval mode), e.g.: 4-10,20 elements.

Number of bar codes
(Completeness)

In the section Completeness, the number of the bar codes to be decoded
within a read cycle (one reading gate) is set.

Quiet zone recognition Quiet zone: The area to the left and right of the bar code
Module: width of the narrowest bar in the bar code
According to code specifications, each bar code must have a quiet zone that is
10x as wide as the module of the bar code.
Example: For a code with a module of 0.5 mm, there must be 5 mm of empty
space to the left and right.
By default, the bar code reader checks a quiet zone that is 7x greater than the
module. This means 7x or greater is acceptable for the bar code reader.

Equal scans Specifies how often a code must be decoded before the result is valid and out-
put.

No time correlation be-
tween two identical la-
bels

If this parameter is set, a gap between two identical labels is ignored and they
are treated as a single label.



Configuration and diagnostics software – Sensor Studio

Leuze electronic GmbH + Co. KG CR110 21

No position correlation
between two labels

If this parameter is set, the position of a bar code label in the reading beam is
not taken into account. Identical labels are treated as a single label.

NOTICE

If the code EAN 128 is to be read, 3 additional characters are to be set for the code identifier.

NOTICE

In general, the remaining parameters must not be changed. In the worst case, this could corrupt
the read result.

Fig. 6.4: Decode > Symbologies

Symbologies In the window Symbology the code-specific settings such as the check digit
can be selected.
Access the window Symbology with the button Symbology to the right of the
respective code, after the column Element number in the Decode tab. Alterna-
tively, the property settings can be selected directly in the menu Decode >
Symbologies.
The properties can be individually set for each code type.
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6.5.2 Output tab

Fig. 6.5: Output tab

Output header Select from the options listed below. The output header is sent in a separate
message before the read result.

Label header The label header is set directly before the code data.

Label footer The label footer is appended directly to the code data.

Message mode Selects whether the bar codes read are sent in concatenation or separately as
individual strings.
NOTICE! The structure of this message string is depicted symbolically in
the preview window.

No read string This character is set for each unrecognized bar code. Multiple characters
(=string) may be entered here. Up to 20 characters are possible.

Output properties Set the desired formatting modes and formatting characters as necessary.



Configuration and diagnostics software – Sensor Studio

Leuze electronic GmbH + Co. KG CR110 23

Fig. 6.6: Output properties – Default settings
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6.5.3 Control tab

Fig. 6.7: Control tab

Activation

Sensor 1 function See menu Sensor
Single read command Command character for starting a single read. In single read mode the reading

gate will be automatically closed after one successful read.

Continuous read com-
mand

Command character for starting the continuous read. In continuous read mode
the reading gate will be automatically reopened until it is closed by a deactiva-
tion signal.

Decode delay time This point is usually used only for test purposes. After the time set here has
passed, the bar code reader automatically reactivates itself following a reading
gate end (e.g. in combination with the option Autostart after decode).

Deactivation

Sensor 1 function See menu Sensor
Immediately after com-
plete decode result

If the setting is activated, the read result is output immediately after the bar
code is decoded.
If the setting is deactivated, the read result is sent only after the trigger signal is
returned (= end of reading gate).

Single read command Command character for canceling a single read.

Continuous read com-
mand

Command character for stopping the continuous read.

Time If the bar code reader is activated, the reading gate is automatically closed by
the bar code reader after this preset time has elapsed (e.g. for test purposes).

Scans without info Following a successful read, the bar code reader waits for this number of
scans (sequential scans with no read result) before it automatically deactivates
itself.
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6.5.4 Host interface tab

Fig. 6.8: Host interface tab

Select the desired baud rate, the stop bits, the data bits, the parity and various transmission modes here.
After switching on the device, these parameters are not active until after the automatic "Power-On" test.
The desired acknowledgment settings are also to be set in this selection window.

Fig. 6.9: Host interface > Framing protocol – default settings
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Here, you can change the address settings and the protocol for sending and receiving.

NOTICE

To be able to continue to communicate with a device following a parameter transfer, you may
need to make appropriate adjustments to the communication properties of the device in the
Sensor Studio configuration software.

6.5.5 Reference code tab

Fig. 6.10: Reference code tab

A reference code is bar code information which is stored in the memory of the bar code reader.
This reference code can be compared with the current decoded bar code in various modes and, thus, the
switching output be set appropriately. For this purpose, the switching output in the menu Switch is still set
to the function Reference Code Compare (Positive Reference Code Compare or Negative Reference Code
Compare).
One possibility to save the reference code is to manually enter the value in this menu. For other possibili-
ties offered by the reference code teach-in see chapter 8.

Type Select the code type.

Info Contents of the reference code.

Compare mode Select here how the internally stored reference code is to be compared with
the decoded result.
For additional comparison possibilities, select the button Properties or the
menu Reference code > Properties.



Configuration and diagnostics software – Sensor Studio

Leuze electronic GmbH + Co. KG CR110 27

Fig. 6.11: Reference code > Properties - Default settings

6.5.6 Sensor tab

Fig. 6.12: Sensor tab

Invert Here, the input level can be inverted.

Debounce time This time period must lapse until the trigger signal is regarded as valid.



Configuration and diagnostics software – Sensor Studio

Leuze electronic GmbH + Co. KG CR110 28

Delay on time The trigger signal is passed on delayed by the specified time period.

Pulse duration If the value is higher than "0": duration of the activation, regardless of how long
the trigger signal has been applied.

Delay off time After the end of the trigger signal, the pulse is extended internally by this time
period.

Function Event that is started when the switching input is activated.

NOTICE

If switch-off delay is activated, the parameter Pulse duration should be "0".

6.5.7 Switch tab

Fig. 6.13: Switch tab

Activation Select the desired event which is to initiate the switching of the switching out-
put here.
Multiple events can also be simultaneously activated.

Deactivation Shown here is the event which results in the switching output being reset if the
set pulse duration has not yet expired.
Multiple events can also be simultaneously activated.

Invert Here, the input level can be inverted.

Pulse duration Duration of the switching output pulse.

Pulse delay Length of time before the switching output is activated.
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7 Starting up the device - Configuration

7.1 Measures to be performed prior to the initial commissioning

NOTICE

Ä Observe the notices for device arrangement, see chapter 4.1 "Selecting a mounting loca-
tion".

Ä If possible, always trigger the bar code reader with the aid of commands or an external sig-
nal transmitter (photoelectric sensor).
ð Only then can you be certain whether a code has been read. If read, the code contents

are transmitted; if not, the NoRead character is transmitted at the end of the reading
gate.

Ä Before commissioning, familiarize yourself with the operation and configuration of the de-
vice(s).

Ä Before connecting the supply voltage, recheck all connections and ensure that they have
been properly made.

7.2 Starting the device

"Power On" test
After connecting the supply voltage, the bar code reader performs an automatic "Power On" function test.
During the start-up phase, the status LED on the rear of the bar code reader illuminates orange.
When the LED switches off, the bar code reader is ready for operation. Any stored customer-specific set-
tings are active.

Interface
Proper function of the interface can most easily be tested in service operation using the RS 232 interface
with the Sensor Studio configuration software and a notebook computer.

Online commands
Using the online commands, important device functions can be checked, e.g. reading activation; see chap-
ter 8 "Online commands".

Problems
For information on how to proceed in the event of problems during commissioning of the devices, see
chapter 10 "Diagnostics and troubleshooting".
If a problem occurs that cannot be rectified even after checking all electrical connections and settings on
the devices and on the host, contact your responsible Leuze subsidiary or Leuze customer service; see
chapter 11 "Service and support".

7.3 Setting the configuration parameters
You have now commissioned the device. Usually, you will have to configure it before you can use it. Using
the configuration options offered by the Sensor Studio configuration software or by means of the device
DTM, the bar code reader can be individually configured according to your application. For information on
the various configuration options, see chapter 6.5 "Configuration parameters" or refer to the online help.

• To operate the bar code reader, it is normally sufficient to set code type and code length in accordance
with the bar codes that are to be read.

• Depending on the application, you can configure the switching input and switching output according to
your requirements.

The setting of code type and code length is usually accomplished by using the Sensor Studio configuration
software, see chapter 6.5 "Configuration parameters".
The various parameter sets are explained in brief to understand what is happening during parameter set-
ting, see chapter 7.3.1 "Parameter sets".
The parameters are then set using the selection in the menu CONFIGURATION. To transfer the settings to
the device, its RS 232 settings must be set to the Service mode, see chapter 7.3.2 "Service mode".
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7.3.1 Parameter sets

Factory default parameter set
This parameter set contains the factory-set default settings for all parameters of the bar code reader. It is
permanently stored in the FLASH ROM of the bar code reader.
The parameter set with the default settings is loaded into the memory of the bar code reader:

• The first time the device is commissioned after delivery.
• With the Sensor Studio configuration software via the button [Factory default] in the menu DIAGNOSIS.
• After the online command PC20 (see chapter 8.4 "Online commands for the parameter set operations")
• If the checksums of the current parameter set are invalid.

Current parameter set
In this parameter set, the current settings for all device parameters are stored. When the bar code reader is
in operation, the current parameter set is stored in the EEPROM of the bar code reader.
The current parameter set can be stored:

• By copying a valid parameter set from the host computer into the bar code reader.
• By an off-line configuration using the Sensor Studio configuration software and then subsequently load-

ing to the bar code reader.
The current parameter set is loaded into the main memory of the bar code reader:

• by the online command Copy parameter set (see chapter 8.4 "Online commands for the parameter set
operations").

7.3.2 Service mode
You can connect a PC or a terminal to the device via the RS 232 interface and configure the device
through this connection; see chapter 5.4 "PC or terminal connection".
Setting the required parameters is carried out most easily in the 'Service' operating mode.
The Service mode provides the following defined operating parameters on the RS 232 interface, no matter
how the device is configured for standard operation:

• Transmission rate: 9600 Bd
• No parity
• 8 data bits
• 1 stop bit
• Prefix: STX
• Postfix: CR, LF

Activating the service interface
The service interface can be activated by holding a defined bar code label in front of the reading window
during power-up (initialization phase).

Fig. 7.1: Bar code label "Service"

Ä While the red light is switched on for approx. 1 s after power-up, the "Service" label is to be held up in
front of the bar code reader at a suitable read distance.

ð When the device is in Service mode, the status LED flashes orange.
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8 Online commands

8.1 Overview of commands and parameters
Online commands can be used to send control and configuration commands directly to the device. For this,
the bar code reader has to be connected to a computer (host) via the serial interface, see chapter 7.3.2
"Service mode".
Information about the transmission protocol: see chapter 6.5.4 "Host interface tab".
Using the online commands you can:

• control/decode the reading gate.
• read/write/copy parameters.
• carry out an automatic configuration.
• teach-in/set a reference code.
• call up error messages.
• call up statistical device information.
• carry out a software reset in order to reinitialize the device.

Syntax
Online commands consist of one or two ASCII characters followed by command parameters.
No separation characters may be entered between the command and the command parameter(s). Both
small and capitalized letters can be used.

Tab. 8.1: Syntax example

Command ’CA’: autoConfig function

Parameter ’+’: Activation

Transmitted is: ’CA+’

Notation
Commands, parameters and returned data are enclosed between single quotation marks ' ' in the text of
this manual.
Most online commands are acknowledged by the device and any requested data returned. For commands
that are not acknowledged, command execution can be observed or monitored directly on the device.

8.2 General online commands

Software version number

Command ’V’
Description Requests device version information

Parameter None

Acknowledgment Example: ’CR110 V 00.16 25.12.2025’
The first line contains the device type of the bar code reader, followed by the
device version number and version date. The data which is actually displayed
may vary from the values given here.

NOTICE

You can use this command to check whether the communication between PC and bar code
reader is functional. If you do not receive an acknowledgment, please check the interface con-
nections or the protocol.
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Software reset

Command ’H’
Description Carries out a software reset. The device is restarted and reinitialized, leaving it

in the same state as when the supply voltage is switched on.

Parameter None

Acknowledgment ’S’ (start signal)

autoConfig

Command ’CA’
Description Activates or deactivates the autoConfig function. Certain label reading parame-

ters are programmed automatically in the setup by the label which is read by
the device while the autoConfig function is active.

Parameter ’+’ Activates ’autoConfig’

’/’ Rejects the last code read

’-’ Deactivates ’autoConfig’ and stores the decoded data in the
current parameter set.

Acknowledgment ’CSx’

x Status

’0’ Valid ’CA’ command

’1’ Invalid command

’2’ ’autoConfig’ could not be activated.

’3’ ’autoConfig’ could not be deactivated.

’4’ Result could not be deleted.

Description ’xx yy zzzzzz’

xx Code type of the read code

’01’ 2/5 Interleaved

’02’ Code 39

’06’ UPC-A / UPC-E

’07’ EAN

’08’ Code 128, EAN 128

’09’ Pharmacode

’10’ EAN/UPC

’11’ Codabar

’12’ Code 93

yy Number of elements of the read code

zzzzzz Contents of the decoded label. A ↑ appears if the label was
not correctly read.
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Manual definition of the reference code

Command ’RS’
Description This command can be used to define a new reference code in the device by

means of direct input via the serial interface. The data is saved in the parame-
ter set according to your input under reference code 1 or 2 and stored in the
working buffer for direct further processing.

Parameter ’RSyvxxzzzzzzzz’
y, v, x and z are placeholders (variables) for the actual input.

y Def. reference code no.

’1’ (code 1)

’2’ (code 2)

v Storage location for reference code:

’0’ RAM+EEPROM

’3’ RAM only

xx Def. code type (see command ’CA’)

z Def. code information (1 … 30 characters)

Acknowledgment ’RSx’

x Status

’0’ Valid Rx command

’1’ Invalid command

’2’ Insufficient memory for reference code

’3’ Reference code has not been saved

’4’ Reference code invalid

Example Input = ’RS130678654331’
• Code 1 (1)
• RAM only (3)
• UPC (06)
• Code information

Teach-in

Command ’RT’
Description This command enables a reference code to be defined quickly by reading an

example label.

Parameter ’RTy’

y Function

’1’ Defines reference code 1

’2’ Defines reference code 2

’+’ Activates the definition of reference code 1 or 2

’-’ Ends the teach event
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Command ’RT’
Acknowledgment The device first responds with the command ’RS’ and corresponding status

(see command ’RS’). After a bar code has been read, it sends the result in the
following format:
’RCyvxxzzzzz’
y, v, x and z are placeholders (variables) for the actual input.

y Def. reference code no.

’1’ (code 1)

’2’ (code 2)

v Storage location for reference code:

’0’ RAM+EEPROM

’3’ RAM only

xx Def. code type (see command ’CA’)

z Def. code information (1 … 30 characters)

NOTICE

With this function, only code types are recognized that are identified using the ’autoConfig’ func-
tion or which were set in the set-up.

Ä After each reading via an ’RTy’ command, explicitly switch off the function again since failure to do so
will interfere with other commands as well as prevent execution of a new ’RTy’ command.

Reading a reference code

Command ’RR’
Description The command reads out the reference code defined in the device. If no param-

eters are specified, all defined codes are output.

Parameter <reference code number>

’1’ Reference code 1

’2’ Reference code 2

Acknowledgment If no reference codes are defined, the device responds with the command ’RS’
and corresponding status (see command ’RS’).
For valid codes, the output corresponds to the following format:
’RCyvxxzzzzz’
y, v, x and z are placeholders (variables) for the actual input.

y Def. reference code no.

’1’ (code 1)

’2’ (code 2)

v Storage location for reference code:

’0’ RAM+EEPROM

’3’ RAM only

xx Def. code type (see command ’CA’)

z Def. code information (1 … 30 characters)
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Alignment mode

Command ’JP’
Description This command is used for simplified mounting and alignment of the device in

static installation situations. After activating the function with ’JP+’, the bar
code reader continuously supplies status information to the serial interfaces.
With this online command, the bar code reader is set to terminate the decoding
after 100 successfully decoded labels and output the status information. Sub-
sequently, the read process is reactivated automatically.
As status, the output returns the following values:

• Scans which contain the valid label information on the basis of 100 scans
• The decoding result

These values can be used to determine the decoding quality:
• If the reading quality is high, the red light beam flashes in brief, regular in-

tervals.
• The worse the decoder decodes, the longer the pauses become during

which the red light is switched off.

Parameter ’+’ Starts the adjustment mode.

’-’ Ends the adjustment mode.

Acknowledgment ’xxxxx_yyyyy’

xxxxx "Scans since reading gate release" (Scans_with info):
Number of scans that contain valid label information. The
maximum value is 100.

yyyyy Bar code information

8.3 Online commands for system control

Activating sensor input

Command ’+’
Description The command activates decoding.

Parameter None

Acknowledgment None

Deactivating sensor input

Command ’-’
Description The command deactivates decoding.

Parameter None

Acknowledgment None

Activate switching output

Command ’OA’
Description The command activates the switching output.

Parameter ’OAx’: Activate switching output

x Switching output no.

’1’ (Output 1)

Acknowledgment None
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Deactivate switching output

Command ’OD’
Description The command deactivates the switching output.

Parameter ’ODx’: Deactivate switching output

x Switching output no.

’1’ (Output 1)

Acknowledgment None

8.4 Online commands for the parameter set operations

Definitions
• <BCC type> Type of checksum calculation.

’0’: No checksum
’3’: XOR checksum (mode 3)

• <PS type> Parameter set type
’0’: Current parameter set (data stored non-volatilely in the EEPROM)
’1’: Reserved
’2’: Standard parameter set (not changeable)
’3’: Operating values (data in the RAM, will be lost after reset)

• <Status> Mode of parameter processing
'0': Does not perform a reset following the write operation; no other parameters follow.
'1': Does not perform a reset following the write operation; other parameters follow.
'2': Subsequently performs a reset, no additional parameters follow.

• <Start address> Relative address of the parameter within the parameter set
• <Para0L> <Para0H>… <Para122L> <Para122H>:

Parameter set data of the message. The sequence of the data is arranged identically to the device, i.e.
when a word is transmitted, first the low byte is sent then the high byte. The parameter set data is con-
verted for transmission from HEX format to a 2-byte-ASCII format. During the conversion, two ASCII
characters – representing the lower nibble and the higher nibble – are created for each HEX value.
Example:

Decimal Hex Transmission

4660 0x1234 '1' '2' '3' '4' = 31h 32h 33h 34h

• Para0H = 31h, Para0L = 32h, Para1H = 33h, Para1L = 34h
Taking into consideration the maximum message length and the remaining command parameters, a
maximum of 123 bytes on parameter data (246 bytes on message data) can be transmitted in a single
operation.
Valid values: '0' … '9', 'A' … 'F'

• <Acknowledgment>:
Acknowledgment of the transmitted message
'0': Valid transmission
'1': Invalid message
'2': Invalid message length
'3': Invalid block check type
'4': Invalid block check checksum
'5': Invalid data length
'6': Invalid message data
'7': Invalid start address
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'8': Invalid parameter set
'9': Invalid parameter type

Copying parameter set

Command ’PC’
Description The command copies complete parameter sets.

Parameter ’03’ Copy parameters from the EEPROM into the RAM and initialize all
associated functions.

’20’ Copy standard parameters from the FLASH into the EEPROM and
RAM and initialize all relevant functions.

’30’ Copy parameters from the RAM into the EEPROM.

Acknowledgment ’PSx’

x Status

’0’ Valid transmission

’1’ Invalid message

’2’ Invalid message length

’3’ Invalid block check type

’4’ Invalid block check checksum

’5’ Invalid data length

’6’ Invalid message data

’7’ Invalid start address

’8’ Invalid parameter set

’9’ Invalid parameter type

Example ’PC20’ loads the default parameters (factory setting).

Requesting parameter set from device

Command ’PR’
Description The command requests the parameter data from the device. The <PS type>

parameter indicates from which parameter set the data are to be transferred.

Parameter <BCC type> <PS type> <Start address> <Data length>

Acknowledgment ’PSx’

x Status

’0’ Valid transmission

’1’ Invalid message

’2’ Invalid message length

’3’ Invalid block check type

’4’ Invalid block check checksum

’5’ Invalid data length

’6’ Invalid message data

’7’ Invalid start address

’8’ Invalid parameter set

’9’ Invalid parameter type

Example ’PR00102004’
Beginning with address 102, four (004) bytes are read out and transmitted.
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Acknowledge parameter message

Command ’PS’
Description The command acknowledges the received message and delivers an acknowl-

edgment status which indicates whether the message was valid or invalid.

Parameter ’PSx’

x Status

’0’ Valid transmission

’1’ Invalid message

’2’ Invalid message length

’3’ Invalid block check type

’4’ Invalid block check checksum

’5’ Invalid data length

’6’ Invalid message data

’7’ Invalid start address

’8’ Invalid parameter set

’9’ Invalid parameter type

Transfer parameters

Command ’PT’
Description The command transmits parameter data beginning with the set address and

stores it there in an intermediate buffer.
If the status indicates that further messages follow, these are also stored in the
intermediate buffer before they are then stored under the corresponding pa-
rameter set type in the EEPROM.
The transmission can optionally occur with a block check test of the message
data.

Parameter <BCC type> <PS type> <Status> <Start address> <Para0L> <Para0H>
[… <Para122L>][<BCC>]

Acknowledgment ’PSx’

x Status

’0’ Valid transmission

’1’ Invalid message

’2’ Invalid message length

’3’ Invalid block check type

’4’ Invalid block check checksum

’5’ Invalid data length

’6’ Invalid message data

’7’ Invalid start address

’8’ Invalid parameter set

’9’ Invalid parameter type

Example ’PT03203305’
Address 33 (equal scans) is set to 5. Save in RAM with reset (immediate ac-
ceptance of the change and temporary storage)
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9 Care, maintenance and disposal
Cleaning
Clean the protective screen of the device with a soft cloth before mounting.

NOTICE

Do not use aggressive cleaning agents!
Ä Do not use aggressive cleaning agents such as thinner or acetone for cleaning the device.

Maintenance
Usually, the device does not require any maintenance by the operator.
Repairs to the device must only be carried out by the manufacturer.
For repairs, contact your responsible Leuze subsidiary or Leuze customer service (see chapter 11 "Service
and support").

Disposing

NOTICE

For disposal observe the applicable national regulations regarding electronic components.
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10 Diagnostics and troubleshooting
Error, warning and status messages of the device are transmitted via the RS 232 interface.

Troubleshooting
Isolated warnings can be ignored, since the device will continue to function properly.
Following a serious error, you should reinitialize the device. It will then usually again function properly. If a
hardware problem is present, the device will not reinitialize.
Frequently occurring warnings and errors can be most easily rectified via the Sensor Studio configuration
software or CR110 DTM.
If you cannot rectify faults and errors with the configuration software, please contact your responsible
Leuze subsidiary or Leuze customer service (see chapter 11 "Service and support").

Tab. 10.1: Errors, causes of errors and measures

Faults Possible error cause Measures
No communication possible Incorrect wiring Check wiring

Wrong interface selected Select the correct interface in the Sen-
sor Studio configuration software.

Different protocol settings Check protocol settings in the device and
in the Sensor Studio configuration soft-
ware or switch the device to the Service
mode.

No code reading possible Code reading not possible
(quality)

Improve code quality! Place the entire
code near the center of the illumination
line.

Code not enabled Check entries in the code table (type and
length).

Excessive reflections Increase angle of rotation of the red light
beam to > 10° with respect to vertical.
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11 Service and support
Service hotline
You can find the contact information for the hotline in your country on our website www.leuze.com under
Contact & Support.

Repair service and returns
Defective devices are repaired in our service centers competently and quickly. We offer you an extensive
service packet to keep any system downtimes to a minimum. Our service center requires the following in-
formation:

• Your customer number
• Product description or part description
• Serial number or batch number
• Reason for requesting support together with a description

Please register the merchandise concerned. Simply register return of the merchandise on our website
www.leuze.com under Contact & Support > Repair Service & Returns.
To ensure quick and easy processing of your request, we will send you a returns order with the returns ad-
dress in digital form.

What to do should servicing be required?

NOTICE

Please use this chapter as a master copy should servicing be required!
Ä Enter the contact information and fax this form together with your service order to the fax

number given below.

Customer data (please complete)

Device type:

Serial number:

Firmware:

Status of LEDs:

Error description:

Company:

Contact person/department:

Phone (direct dial):

Fax:

Street/No:

ZIP code/City:

Country:

Leuze Service fax number:
+49 7021 573 - 199
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12 Technical data

12.1 General specifications

Tab. 12.1: Optical data

Light source LED, red

Wavelength 624 nm (visible red light)

Light beam exit CR110M0/R2: lateral (12° ±2°)
CR110M2/R2: at front

Scanning rate 780 scans/s

Modulus size / resolution 0.15 … 0.5 mm / 6 … 20 mil

Reading distance see chapter 12.2 "Reading fields"

Reading field opening see chapter 12.2 "Reading fields"

Tab. 12.2: Read data

Code types 2/5 Interleaved
Codabar
Code 39
Code 93
Code 128
EAN/UPC
EAN 128
EAN Addendum
Pharma Code

Functions LED indicator
Output format selectable
Multiple read
Real time decoding
Control of the switching input/output

Tab. 12.3: Electrical equipment

Supply voltage UB 4.5 … 5.5 V DC
NOTICE! For UL applications: only for use in ES1/PS1 circuits ac-
cording to UL/IEC 62368-1.

Degree of protection IP40

Protection class III

Current consumption, max. 250 mA
2 W power supply unit recommended

Digital switching input 1, 5 V DC

Digital switching output 1, 5 … 30 V DC, 20 mA
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Tab. 12.4: Interface

Type RS 232, freely configurable

Baud rate 300 … 115200 Bd

Data formats Data bits: 7, 8
Parity: none, even, odd
Stop bit: 1, 2

Protocols Framing protocol with/without handshake
Software handshake X ON / X OFF

Service interface RS 232 with fixed data format
9600 Bd, 8 data bits, no parity, 1 stop bit
<STX> <data> <CR><LF>

Tab. 12.5: Mechanical data

Dimensions (W x H x L) CR110M0/R2 (lateral beam exit): 55 x 52 x 20 mm
CR110M2/R2 (front beam exit): 55 x 20 x 47 mm

Weight 200 g

Type of connection Cable, 6 x 0.081 mm² (AWG 28)

Cable length 2,000 mm

Housing material Metal

Tab. 12.6: Environmental data

Ambient temperature, opera-
tion

0 °C … +45 °C

Ambient temperature, storage -25 °C … +60 °C

Relative humidity (non-con-
densing)

max. 90 %

Electromagnetic compatibility EN 55016
IEC 61000-4-2, -3, -4, -6, -8

Conformity CE, FCC Class B

Certifications UL recognized under way
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12.2 Reading fields

NOTICE

Please note that the actual reading fields are also influenced by factors such as labeling mate-
rial, printing quality, scanning angle, printing contrast etc., and may thus deviate from the read-
ing fields specified here. The origin of the read distance always refers to the front edge of the
housing of the beam exit.

x Typical reading distance [mm]
y Typical reading field width [mm]
r1 m=0.15 mm (6 mil)
r2 m=0.2 mm (8 mil)
r3 m=0.25 mm (10 mil)
r4 m=0.35/0.5 mm (14/20 mil)

Fig. 12.1: Reading field of CR110M0/R2 for Code 128, Grade A

x Typical reading distance [mm]
y Typical reading field width [mm]
r1 m=0.15 mm (6 mil)
r2 m=0.2 mm (8 mil)
r3 m=0.25 mm (10 mil)
r4 m=0.35/0.5 mm (14/20 mil)

Fig. 12.2: Reading field of CR110M2/R2 for Code 128, Grade A



Technical data

Leuze electronic GmbH + Co. KG CR110 45

12.3 Dimensioned drawings

CR110M0/R2 with lateral beam exit

all dimensions in mm
A Status LED
B Optical axis

Max. thread depth of the M3 fastening screwsin the housing: 3 mm!

Fig. 12.3: Dimensioned drawing of CR110M0/R2 with lateral beam exit
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CR110M2/R2 with front beam exit

all dimensions in mm
A Status LED
B Optical axis

Max. thread depth of the M3 fastening screwsin the housing: 3 mm!

Fig. 12.4: Dimensioned drawing of CR110M2/R2 with front beam exit
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13 Order guide and accessories

13.1 Type overview

Tab. 13.1: Type overview

Part no. Designation Description
50154391 CR110M0/R2 Stationary bar code reader, lateral beam exit, medium density

50154392 CR110M2/R2 Stationary bar code reader, front beam exit, medium density

13.2 Accessories

Tab. 13.2: Accessories

Part no. Designation Description
50128204 MA-CR Adapter circuit board with spring terminals and 9-pin SUB-D

socket

50113396 KB DSub-9P-3000 RS 232 interconnection cable, cable length 3 m
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14 Declaration of Conformity
The code readers of the CR110 series have been developed and manufactured in accordance with the ap-
plicable European standards and directives.

NOTICE

You can download the EC Declaration of Conformity from the Leuze website.
Ä Call up the Leuze website: www.leuze.com.
Ä Enter the type designation or part number of the device as the search term. The article num-

ber can be found on the name plate of the device under the entry "Part. No.".
Ä The documents can be found on the product page for the device under the Downloads tab.
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15 Appendix

15.1 Bar code samples

Module 0.3

Fig. 15.1: Code type 01: 2/5 Interleaved

Module 0.3

Fig. 15.2: Code type 02: Code 39

SC 2

Fig. 15.3: Code type 06: UPC-A

SC 3

Fig. 15.4: Code type 07: EAN 8

Module 0.3

Fig. 15.5: Code type 08: Code 128

Module 0.3

Fig. 15.6: Code type 08: EAN 128
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SC 0                                    S

Fig. 15.7: Code type 10: EAN 13 add-on

Module 0.3

Fig. 15.8: Code type 11: Codabar
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